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Introduction

t the height of its worldwide popularity, QuarkXPress had almost 4 million

users. That proved too tempting a plum for the competing Adobe jugger-

naut not to pluck from the desktop publishing pie, so over the course of
10 years, Adobe was able to draw many graphic designers to InDesign by providing
it for free in bundles with Photoshop and Illustrator. Meanwhile, Quark underwent
a complete metamorphosis, changing ownership and management to become the
company that created this jewel of digital publishing: QuarkXPress 2016.

Meanwhile, the publishing industry itself experienced major changes, embracing
multiple ever-changing digital formats — and QuarkXPress evolved along with
these changes. QuarkXPress 2016 is not your father’s, mother’s, or grandparents’
QuarkXPress: Although the program has maintained its trademark efficiency and
focus on the day-to-day needs of real-world publishers, it has also become a mul-
tifunction, platform-agnostic publishing engine capable of efficiently producing
documents for any medium today — or that may present itself in the future.

Many graphic designers lost track of QuarkXPress, and they wonder what kind of
organizations have continued to use it year after year. The simple answer is this:
companies that value time and efficiency over bells and whistles. Financial orga-
nizations, pharmaceutical companies, manufacturing industries, newspapers and
magazines, book publishers, multilingual publishers, and especially East Asian
publishers all rely on QuarkXPress because it saves them time.

QuarkXPress is happily experiencing a resurgence of interest from publishers and
graphic designers, partly because it remains efficient, practical, and elegant, but
also because it combines the features of several competing programs. You can use
it for most tasks that publishers habitually use Adobe Illustrator for — but with
a more efficient interface. (In fact, if you preferred Aldus FreeHand’s efficient,
task-based interface over Illustrator’s byzantine tool-based interface, you might
find yourself using QuarkXPress as if it were FreeHand!)

Another reason is cost: QuarkXPress is still sold with a perpetual license — there
are no monthly fees to use it, and its year-over-year cost is significantly lower
than Adobe’s InDesign or Creative Cloud suite. And now it can convert PDF,
Hlustrator, EPS, InDesign, and Microsoft Office content into native QuarkXPress
items — a first in the industry.

Introduction 1



I’'m proud to have been asked to contribute a book to this successful book series.
But, don’t be fooled by the series title. If you are using or considering using
QuarkXPress, you are far from being a dummy. This is world-class software that
will efficiently and effectively support your creative work for years to come.

About This Book

The purpose of QuarkXPress For Dummies is to clearly explain the fundamentals
of how to use all the tools in QuarkXPress. Whether you’re new to QuarkXPress
or upgrading to the latest version, you get answers to your real-world questions
about how stuff works. If you’re looking for a comprehensive book on how to do
absolutely everything in QuarkXPress inside out, backward and wearing heels,
this is not it. That book doesn’t exist — and if it did, it would be three times the
size of this one. This book was written to QuarkXPress 2016 and should be useful
to anyone using QuarkXPress versions back to 8.

To help you absorb the concepts, this book uses the following conventions:

¥ Web addresses appear inmonofont. If you're reading a digital version of this
book on a device connected to the Internet, you can click the live link to visit a
website, like this: http://www.dummies.com.

3 When I tell you to enter text into a field or or some other element, the text you
enter appears in bold.

¥ |list keyboard shortcuts for both Mac and Windows, in that order. For
example, Command-K means press the Command and K keys at the same
time on a Mac; Ctr+K means press the Ctrl and K keys at the same time time
on a Windows PC. Here's how | say this in the book: “Press Command-K (Mac)
or Ctr+K (Windows).” Modifier keys on a Mac include Shift, Option, Command,
and Control; modifier keys in Windows include Shift, Alt, and Ctrl. (The Control
key on a Mac is rarely used for keyboard shortcuts.)

3 When you need to choose an item from the QuarkXPress menu bar, you see
them separated by a special arrow, like this: File=> New File, which tells you to
click File and then click New File.
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Foolish Assumptions

The first assumption is that you’re familiar with Mac OS or Windows, because the
book doesn’t provide any guidance in this regard. This book doesn’t discuss any
platform-specific issues. You need to know how to work with your chosen plat-
form before you begin working with this book.

Icons Used in This Book
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WARNING

As you read this book, you encounter icons in the margins that indicate material
of special interest. Here’s what the icons mean:

Tips help you save time or perform a task in a clever way.

Remember icons mark the information that’s especially important to know.

The Technical Stuff icon marks information that provides a more technical expla-
nation than is absolutely necessary for you to accomplish the task explained in
that section. If you’re deeply interested in the topic, read these. Otherwise, you
can skip them without missing important how-to information.

The Warning icon tells you to watch out! Some stuff that QuarkXPress lets you do
may not be in your best interest, and these warnings help you identify them before
causing irreparable harm to yourself and the fabric of the universe. Or something
less drastic.

Beyond the Book

The great Internet contains a couple of additional resources for readers of this
book:

¥ Cheat Sheet: QuarkXPress is all about efficiency, and nothing is more
efficient than using your keyboard to accomplish tasks. That's why there's a
keyboard shortcut for just about every important operation in the program.
The ones that power users find most useful are collected in the Cheat Sheet
at www . dummies . com (search for QuarkXPress For Dummies Cheat Sheet).
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¥ Updates: If Quark changes something important about QuarkXPress between
the time this book is published and the next major revision of QuarkXPress,
look for updates at www . dummies. com.

Where to Go from Here

This book isn’t linear — you can start almost anywhere if you already under-
stand the basics of how QuarkXPress works. However, if you’re new to QuarkX-
Press, Chapters 1 and 2 familiarize you with its overall purpose and interface.
Chapters 3 and 4 explain how to create Items and work with them. Chapter 5
explains how to use master pages to ensure uniformity across multiple pages.
QuarkXPress has a unique approach to sharing content across pages, layouts, and
even multiple users, and Chapter 7 explains that. Most users spend 80 percent of
their time in QuarkXPress working with text, so Chapters 8 through 11 dive deeply
into the realm of text. Tables, pictures, and colors are explained in Chapters 12
through 15. Printing gets its own chapter (16), followed by a deep immersion into
all the ways you can enhance and export your projects for digital media such as
PDF and e-books. As you complete different kinds of projects in QuarkXPress, you
may think: “There has to be an easier/better way!” so Chapter 18 points you to
additional resources for help with specific topics. And finally, Chapter 19 attempts
to smooth your QuarkXPress path with ten do’s and don’ts that are easy to forget
but powerful if you remember them.
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IN THIS PART ...

Understanding QuarkXPress

What's new in QuarkXPress 2016

Getting to know the interface

Creating and working with boxes, lines and text paths

Converting InDesign, lllustrator, PDF, and Microsoft
Office files to native QuarkXPress items

Building a layout, a project, and a book

Syncing and collaborating with the sharing features



IN THIS CHAPTER

» Getting acquainted with
QuarkXPress

» Finding out what's new in
QuarkXPress 2016

» Catching up with recent versions’
enhancements

» Knowing how to manage your files
from the get-go

» Opening, creating, and saving files

Chapter 1
Meeting QuarkXPress
2016

uarkXPress 2016 is not your daddy’s QuarkXPress. It may not even be

your QuarkXPress if you haven’t used it since version 7. QuarkXPress has

evolved far past its spectacular first incarnation as the world’s greatest
tool for laying out pages for print. Adobe may have infiltrated the desktops of
graphic designers by giving away InDesign, but QuarkXPress is still the industry’s
most efficient engine for producing documents for multiple media. It’s currently
in use by more than a million customers worldwide, especially in markets that
value efficiency, such as manufacturing, financial, real estate, and pharmaceu-
ticals, as well as book publishers, magazines, newspapers, and a wide variety of
retailers and smart graphic designers.

In this chapter, I give you a brief overview of some QuarkXPress fundamentals
and bring you up to speed on the new features in QuarkXPress 2016 as well as the
major enhancements added to recent versions. Also, I provide some real-world
advice for creating, naming, and organizing your files, opening older QuarkXPress
documents, and saving your QuarkXPress 2016 document so that it can be read by
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QuarkXPress 2015. And finally, I point you to a hidden feature that saves backup
copies of your files.

Understanding What QuarkXPress Does

8

©
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TIP

QuarkXPress is a page layout program. To build a page, you draw a few boxes (con-
tainers) and fill them with content (text, pictures, and other stuff). Add a few rules
(lines) and frames (picture edges) and you have a layout. If you’re clever, you link
your page to a master page (which holds items such as page numbers and headers
that repeat on multiple pages) and organize your page items on layers (to cluster
related items together for viewing or printing).

Everything on a QuarkXPress page is referred to as an item.

Over the years, QuarkXPress has evolved to support the needs of publishers and
designers with major new capabilities such as interactive and animated items,
Bézier (pen) tools that rival Adobe Illustrator, real-time collaboration with others
working on the same document, creating e-books and even mobile apps, supply-
ing powerful table-creation tools, converting content from other programs into
native QuarkXPress items, creating anchored callouts, and providing support for
dozens of languages in the same document.

In case the built-in features aren’t enough for you, you can buy and add third-
party XTensions to QuarkXPress, which are plug-ins that add new capabilities
ranging from one feature to an entire automated database publishing system.

Quark is the company’s name. QuarkXPress is the product’s name. Quark has other
products besides QuarkXPress. Just as you would never say “Adobe” when refer-
ring to Photoshop or Acrobat, or “Microsoft” when referring to Word or Excel,
you don’t refer to QuarkXPress as “Quark.” That said, you commonly hear people
say “Quark” when referring to QuarkXPress. Use your social judgment to decide
which name you want to use.

Quark was founded by a science geek who named the company after the elemen-
tary particle that is a fundamental constituent of matter. In keeping with that
science nerdiness, one XTension (QuarkXPress plug-in) developer cleverly named
his company Gluon, which is the elementary particle that “glues” quarks together
to form protons and neutrons.
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HOW QUARK REVOLUTIONIZED
PUBLISHING

Quark was founded in 1981 in Denver, Colorado, by Tim Gill. After writing several
successful programs for the Apple Il and Apple Il computers (including Word Juggler
and Catalyst), Gill saw Apple’s Macintosh computer and realized that it could change
the world of publishing. Until that time, publishing systems were available to only the
wealthiest members of society, at a cost of several hundred thousand dollars. But in the
late 1980s, all publishing required was a Macintosh, QuarkXPress, and a LaserWriter —
at a total cost of less than $10,000.

This tenfold reduction in the price of publishing indeed created a new worldwide indus-
try that came to be known as Desktop Publishing. But most important, it put publishing
into the hands of those formerly without a voice. This was the idea that most excited Gill,
who in 1986 took on a financial partner named Fred Ebrahimi. Together, they conquered
the publishing world in several ways: by building QuarkXPress into the tool that 90 per-
cent of publishers wanted to use; by extending its reach into historically disenfranchised
areas of the world such as India, Latin America, and portions of East Asia; and by sup-
porting a cottage industry of trainers and XTension developers.

Being a programmer himself, Gill had a special place in his heart for independent
programmers who wanted to make a difference in the world but wanted to work for
themselves. He held training events for XTension developers, invited them to Quark’s
events, and even helped set up a worldwide marketing distributor for XTensions so that
the developers could spend their time coding instead of marketing. Quark benefitted,
of course, by being able to focus on improving the core set of features in QuarkXPress
needed by most users, and allowing the XTension developers to provide solutions for
specific needs. When some of those XTensions later became features in QuarkXPress,
Gill always tried to take care of the developers. (When Quark released a Windows ver-
sion of QuarkXPress, Gill cleverly released free XTensions to give features to Mac users
that weren't possible to create in Windows.)

In 2000, Gill sold his half of Quark to Fred Ebrahimi to focus on philanthropic endeavors
such as The Gill Foundation. Quark and QuarkXPress never fully recovered from Gill's
departure, but still maintain a strong presence in enterprise and vertical markets that
value efficiency. (In 2006, Fred Ebrahimi gave all his shares of Quark Inc. to his children,
with his daughter Sasha taking the position of Chairman. In 2006, Quark also hired
Raymond Schiavone, former CEO of Arbortext, as its new CEO. In 2011, the Ebrahimi
family sold all its shares to Platinum Equity, a California-based private equity firm that
focuses on underperforming companies with high potential.)
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Getting a Feel for What's New
in QuarkXPress 2016

10

The biggest new feature in QuarkXPress 2016 is the capability to convert imported
PDF, EPS, and Adobe Illustrator files to native, editable QuarkXPress objects. You
can even convert objects or entire pages from Adobe InDesign, Adobe Illustrator,
Microsoft Office (including Word, Excel, and PowerPoint), CorelDRAW, Affinity
Designer, and other apps.

The program sports many other new features as well. You can export any QuarkX-
Press layout as an HTML5 publication, enabling you to create an app-like experi-
ence in a web browser or mobile device — complete with interactive objects and
all the typographic control in QuarkXPress. You can create multicolor blends (gra-
dients), each color with its own level of opacity. The new Fit Box to Text feature
resizes a text box so that if your text is shorter than the box, or if it overflows the
box, the box resizes to fit the text. This feature even balances text in boxes that
have multiple columns of text. The new Color Picker (formerly only available as an
XTension) lets you click any item (including imported pictures) to add new color
swatches to your layout. You can access Stylistic Sets included in advanced Open-
Type fonts. You can enlarge the icons and labels on the Measurements palette by
50 percent.

QuarkXPress 2016 also offers improvements to existing features. In previous ver-
sions of QuarkXPress, for example, dynamic guides appear as you drag an item to
show you its spacing in relationship to other items. This feature lets you easily
align and uniformly space items. In QuarkXPress 2016, guides now appear that
show when the edges and centers of text columns and gutters align with other
items in multicolumn text boxes. The Find/Change feature now remembers your
most recent searches; also, it allows you to search for and change nonbreaking
spaces and characters. Content variables can now wrap onto multiple lines just
as regular text does, which is useful for longer headers and for created/modified/
printed slugs. Print experts will appreciate full support for ICCv4 color profiles.
And the QuarkCacheCleaner app now deletes the QuarkXPress Preferences file as
well as the font and picture cache files used by QuarkXPress.

Windows users will be happy to have the modern, efficient user interface that Mac
users have enjoyed in previous releases. And if you use a Mac, you can now pinch,
zoom, and rotate items using gestures on your Mac’s touchpad.

Installing QuarkXPress 2016 on a Mac is now blissfully easy: Just drag it into your
Mac’s Applications folder. In contrast to previous versions, which required XTen-
sions to be rewritten for each new version of QuarkXPress, XTensions written
for QuarkXPress 2015 also work with QuarkXPress 2016 (as long as the XTension
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doesn’t conflict with a new function). And as opposed to Adobe InDesign, QuarkX-
Press doesn’t require payment of an ongoing subscription — its perpetual license
lets you use the program forever.

If you forget which features are new, choose Help= What’s New to be taken to
Quark’s website to find an explanation of the new features.

Introducing the Big Features
in Recent Versions

If you skipped a release or three, you’re not alone — but you’ve missed some
efficiency-enhancing improvements. Conveniently, Quark has provided a chart
of new features that stretches back to version 7 and has allowed me to include it
in the appendix of this book. Here are some of the most exciting and useful new
features introduced since version 7:

»
»
»

»
»
»
»
»
»
»
»
»
»
»
»
»

Intelligent palettes that adapt to your work
Layers on master pages

The capability to drag and drop from other apps, the desktop, and Adobe
Bridge

Having a page size larger than 48 inches

Having multiple page sizes in one document
Crisp display of all images

The capability to scale images up to 5000 percent
An 8000 percent zoom

The capability to import native Photoshop (PSD) and Illustrator (Al) files
The capability to relink images in Usage dialog
Format painter

Item Find/Change

Item Styles

A page thumbnail navigator (Mac only)

Cloner utility copies items or pages across layouts

Intelligent scaling: You choose the attributes to scale
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3 Footnotes/Endnotes

¥ Table styles

¥ Sound, video, and interactivity

¥ The capability to synchronize text, pictures, and formatting automatically
¥ Conditional styles

¥ Callouts

¥ Hanging punctuation

3 Bullets and numbering

¥ Story Editor

3 Redlining

¥ Notes

¥ Glyphs palette

¥ Job Jackets for automated document creation

¥ Print previews

¥ The capability to export to ePub, iPad, Kindle, Android
¥ The capability to export items and pages as images
¥ Advanced east Asian typography

¥ Global language support built in (35+ languages)

¥ Spotlight and QuickLook support (Mac only)

¥ Cross-platform dual-licensing (Mac and Windows)

guage edition of QuarkXPress. Now, a project created in any language edition of
QuarkXPress can be edited, printed, and saved in any other language edition of
rememper  QUarkXPress — no more language-specific projects!

@ In the bad old days, you couldn’t edit a document created in a different lan-

Managing Your Files

12

If you haven’t used a page layout program before, you soon discover that manag-
ing files for QuarkXPress projects is a bit different from how you may have man-
aged them with other kinds of programs. For example, QuarkXPress changes its
file format with every version, so older versions can’t open projects saved by newer
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versions. Also, a QuarkXPress project usually has several parts and pieces that are
best stored together in a folder. You learn about these important topics next.

Futzing with file formats

QuarkXPress 2016 can directly open documents that were last saved by QuarkX-
Press 7 and higher; documents earlier than version 7 require conversion first,
as explained in the next paragraph. You can also copy entire pages from Adobe
InDesign or Illustrator as well as import pages from PDF files, and convert them
to native QuarkXPress items. See Chapter 3 for more on importing and converting
those files.

Every version of QuarkXPress has allowed you to “downsave” a copy of your doc-
ument to the format understood by the previous version. That way, you can hand
off your QuarkXPress 2016 document to someone using QuarkXPress 2015. To
downsave to the previous version, open your document and choose File o> Export =
Layouts as Project. In the resulting dialog box, choose 2015 from the Version
pop-up menu. Unless you want to replace your existing project, give the new one
a different name — perhaps add “qxp2015” to the end. QuarkXPress 2015 then
happily opens the exported document just as if it had created it. However, any
page items that use features not in that version will be either translated to some-
thing that version can understand or removed entirely. (For example, multicolor
blends are converted to two-color blends, cross references are lost, and variables
with line wraps are lost.) Use with caution!

If you use a Mac, you can use its QuickLook feature to preview QuarkXPress docu-
ments that were last saved by version 9 or higher. To do that, click once on the file
in the Finder and then press the spacebar on your keyboard. The first page of the
document appears in a preview window.

Opening projects

Opening an existing project in QuarkXPress is no different from opening a file in
any other application: From within QuarkXPress, choose File=> Open and navigate
to the file. But QuarkXPress also has a handy Welcome screen (see Figure 1-1) that
appears when no project is open, or when you choose Window=> Welcome Screen.

The Welcome screen has three sections:

3 Open a Recent Project: Lists your most recently opened projects. Click one
to open it. To open a different project, click the Other Projects folder icon. This
opens your computer’s standard Open File dialog box.
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FIGURE 1-1:
The Welcome
screen.

TIP

[] Welcome to QuarlcXPress

Q U g R KXPRESS 2016 Quark Receives Dynamic Publishing Strategy

and Leadership Award

Open a Recent Project Create... Resources
£, QXP 2016 review for Macwo... e% Project © App Studio
£}, QXP 2016 for Dummies.gxp & Library @ Quark DesignPad
£, Converted ID IL PDF graphic... © Quark Enterprise
5 Petstumes project.qxp o Facebook
£, Trattoria menus & signs.oxp © Twitter

Buy QuarkXPress

© Quark Store
© Authorized Reseller
© Telesales

% Other Projects... % Documentation...

Don't Show Again

¥ Create...: Lets you create a new project or a new library. (Libraries are
explained in Chapter 4.)

¥ Resources: These Quark-related online resources are updated whenever
Quark feels the need to change them. Click a resource to be taken to its web
page. Below the Resources section is a list of ways to buy QuarkXPress. You
also find a handy Documentation folder icon that opens the folder on your
hard drive containing the QuarkXPress Getting Started reference PDF (in many
languages) along with comprehensive documentation for creating AppleScript
scripts (if you're on a Mac). See Chapter 18 for more on AppleScripts.

Opening older QuarkXPress projects

QuarkXPress 2016 can open documents last saved by QuarkXPress 7 and higher.
(Version 7 is when Quark dramatically modernized the document format.) To open
QuarkXPress documents last saved by versions 3.1-6, first convert them with the
free QuarkXPress Document Converter, available at Quark’s website. (The easiest
way to find it is to type QuarkXPress Document Converter in your web browser’s
search field.)

On a Mac, the File menu in QuarkXPress has a handy Open Recent item that lists
recently saved QuarkXPress projects. To make a similar feature available in Win-
dows, QuarkXPress includes the DejaVu XTension, which is installed automati-
cally. To adjust the number of items it shows, choose Edit= Preferences and click
the File List pane. If you find yourself repeatedly opening projects, saving projects,
and retrieving text and pictures from the same folder, you can also use DejaVu to
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